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Check Included Items

The Silhouette Alta® comes with the items shown in the following list. Check that all the items have

been included before starting. If you are missing any items listed below, please contact
support@silhouetteamerica.com.

A/C adapter and USB cable

power cable
Silhouette Alta®

delta 3D printer

- —

Platform
| (build plate)
Filament i
Filament spool Filament tube
“
Platform tape Small hex  Large hex Nozzle Spatula Keys
key key cleaner
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Take the Silhouette Alta® from the box and remove the strips of packing tape, zip ties, and foam as
indicated by the following pictures. These zip ties and strips of foam are used to hold the moving
parts of the Silhouette in place during shipment.

Install the Silhouette 3D® Software

Installation

1. Navigate to silhouetteamerica.com.

2. Click the blue “Update Software” button at the top of the screen.

3. Under “Silhouette 3D®," go to the row labeled “Current Version.” Click either “Mac®" or
"Windows,"” depending on your operating system, listed under the “Link” column.

FOR WINDOWS: Proceed through the installation process by following the on-screen prompts. If the
installation window does not automatically appear, open the Downloads folder in My Computer and

double-click the setup.exe program to run it.

FOR MAC®: Drag and drop the Silhouette Studio® application icon into the Applications folder to
install Silhouette Studio®.
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Connect the Silhouette Alta®

Once the Silhouette 3D® software is installed, connect the Silhouette Alta® to the power supply.
Then connect the Silhouette to your computer with the included USB cable as shown in the diagram.

o
N2

Turn the machine on by pressing the power button. If your computer displays a “New Hardware
Found” dialog box, follow the recommended instructions to accept your system's installation of the
Silhouette driver.

Opening te Stltowette 30D ® Soffwnie

Locate the Silhouette 3D® icon on the desktop, in the Start Menu on your PC, or in the
Applications folder on your Mac®. Double-click the icon to run the application.

Once Silhouette 3D® has loaded, you will notice a circle with a grid on your screen. This is
your print bed.

o If you would like to change the orientation, you will find the cube in the upper right-hand
corner of the page. By moving this cube around, you can look at your 3D designs from
all angles. To zoom in or zoom out on the print area, you can use the scroll bar on your
mouse or click the magnifying glasses at the top of the Silhouette 3D® window.
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Tavvgation Taby

There is a panel on the right-hand side that shows the following tabs:

[E]JDESIGN & 3DPRINT  §) STORE

Design

This design area is your workspace to create projects.
This area houses the toolbars, the design space, and
the gray holding area. When you are in the 3D Print
or the Store tab, click the Design tab to return to your
design page.

3D Print

The 3D Print tab allows you to adjust the print settings
for your designs and send them to your Alta.

I owrowy | u |

>,

Store

When you are connected to the internet, the Store tab
takes you to the Silhouette Design Store where you
can browse and purchase designs.

A\
A.. I
FREEDESIGN. \ 30% OFF \
I 201

NEW DESIGNS

e a® 2 %2 D g
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Work Area Overview

1. Document Tools

2. Object Tools

3. Drawing Tools

4. Document Tabs

5. Holding Area (Gray)
6. Design/Print Area
7. View Cube

8. Navigation Tabs

9. Cloud/Library Panel

Silhouette Cloud

Silhouette Cloud works hand in hand with Silhouette's software to keep all of your designs synced on
multiple devices. You can sync up to five devices with your cloud account. If you aren't using multiple
devices, Silhouette Cloud is useful in backing up your designs and preventing the need for recoveries.

In Silhouette Cloud, there is unlimited storage available for Silhouette Design Store downloads. There is

1 GB available for custom content. Club Silhouette Members receive 5 GB of storage for custom content.
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The panel on the right-hand side will immediately prompt you to sign in to your Silhouette account, where
you can access your stored designs. Sort and organize your designs any way you would like by adding
folders and subfolders.

< Cloud » Lbrary » Recent Downloads q -’iz g E E g ﬁ

diamond earrings diamond star
Fonts (29) Library Patterns (14)
starflake
¥ abesssihousteameicacom
S — el
Recycle Bin Last Synced: 8/6/2018 11:32:43 AM  610.7 KB used of 1.0 GB

You can also select “Sync” at the bottom of the panel to add any new designs you may have purchased
recently, and that's also where you'll find how much storage is still available.

If at any time you want to minimize the cloud panel, click the tab with the two arrows pointing to the right.
The panel will then minimize. To open the panel again, click the same tab with the arrows now pointing to
the left.
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Design/Print Area

There are two different sections in your workspace: the design space, or the printing area, and the gray
holding area. Images and designs can be placed on both the gray holding area and the printing space.
However, any designs that are in either the white design space or the gray holding area will be designated
as prints when you go to the 3D print tab. You can toggle through the layers and decide which designs
you want to keep and print. Keep in mind that each print must remain within the active print area (bound
inside the red box on the white area). Any parts of the design outside of this area will not be printed.

Document Tabs

Your document tabs are located at the top of your workspace. When you open a new document while you
already have a document open, a new tab will open. The document tab highlighted in white shows which
document is open in your workspace. The other open documents are shown with grayed-out tabs.

Your document tabs allow you to move easily back and forth between multiple projects and let you know

at a glance what projects you currently have open. When you save a file, the document tab automatically
updates to the file name.

Creating Simple Shapes

Silhouette 3D® has built-in functions to draw simple 3D shapes,

such as cubes, spheres, cones, cylinders, and so on. Each of these

shapes can be found in the shape tool on the left-hand side. Click ‘

the shape to open the shape options and select the shape you & A I“fl a3 o A

wish to add to the print area. ; ,~— - ﬁ s
AN IONBRECRE m R

To adjust the size of a shape or object, click and drag one of the

white squares in the corner or at the top of the object. Hold down
the Shift key when you click and drag a white square if you would
like to modify one part of the shape instead of having the shape
change in size overall.

To simply adjust one of the sides without adjusting any other
part of the object, click and drag one of the black squares in the
middle of the line.

To move the object around, click and hold on any part of the
object and drag the object to the desired position.

To move the object vertically, click and hold the black arrow
and drag it up or down. You can also adjust the angle of the
object by clicking and dragging the rounded arrows and letting
go when you reach the desired position.

If you want to delete an object, select the shape, and click the
X'icon, located in the middle of the quick-access toolbar under
the Document Tools.
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Creating Text

side of the screen. When you select the text tool, a box will come up and prompt you to enter your

@ To print letters or words using any font on your computer, choose the Text tool on the left-hand
text.

Type text

Createl

6/140 characters CANCEL

You can move and adjust the text the same way you move and adjust objects. To change the text, double-
click the box and enter the new text. To change the font, make sure the text box is selected and go to the
top of the Silhouette 3D® page. On the left side under the Document Tools, you will see a drop-down

menu where you can select your font. To change the text, double-click on the text and type in the new text.

Getting Started with your Silhouette Alta®
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Document Tools

At the top of the Silhouette 3D® software screen, there are tools to help you with certain view functions in
the document.

. Use these tools to create a new document, open an existing document, or save your
current document.
E You can use these tools to cut, copy, and paste designs to the design area.

To undo the previous action you just made, you can click on the arrow turning to the left. To
=

redo an action you just undid, click on the arrow turning to the right.

P The icon on the left helps you select all of the objects, and the icon on the left deselects all of
[ d the objects you may have selected.

To display or hide the wireframe view, click on this icon.

to see the true distance between objects. The icon on the right changes the display to
perspective view, which is the default view.

S Click on any of these tools to change your view of the design area. From
@ left to right, the tools are zoom in, zoom out, selection zoom, pan, and

fit to page.

@@ The icon on the left changes the display to an orthographic view, meaning it will be easier

Object Tools

When you click on a 3D object, there are object tools that appear in the toolbar below the document tools.
pu

f

» ) You can cycle through these transform tools to flip or rotate objects or text.
To group multiple objects so that you can move them all at once, hold down Shift, click on
each object you wish to group together, and select the group icon. To ungroup the objects,
make sure the box with the objects is selected, and select the Ungroup icon.

If you wish to copy an object, you can click the duplicate icon when an object is selected.
When an object is selected, you can click on this icon to delete the object.
l To bring an object back to the level of the print bed base, click the icon with the arrow

S pointing down to the print bed. To center the icon in the middle of the print bed, click the
icon that looks like a target.
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Preferences

You have the ability to change some of the default settings by adjusting your preferences. Do to so,
go to Edit and select Preferences. You can change the language, the unit of measurement, what to
do when importing an object that is larger than the print bed, and when to check for updates to the
Silhouette 3D® software.

g x
General
Language English v
Unit of Measurement Millimetres ¥
When opening a (@) Ask before Resizing (default)
model larger than the . . .
Print Bed: O Automatically Resize to Fit
O Never Resize
Updates
Check for Updates Weekly v
Enable Performance Improvement data collection. Learn More

Browsing Designs

Once you sign in to the panel on the left-hand side, you'll notice that it includes folders for your
library, your patterns, your fonts, and any designs you may send to the recycle bin. To start looking at
objects you can print with your Alta, click on the Library folder. Any new objects that you download
will automatically go to the Recent Downloads folder.

EFBE )X EE "X @ prsioN

¢ Cloud » Library » Single Modsis O RL

Untitied-1 % [Surprise-Inside Apples3d X -
[m Heart Hook Heart Paperclip Hexagon Coaster

@ “w g

Mandals Coaster  Multiway Cable Tidy ~ Ocean Square
Coas

wy § @

Open-Closed Sign Paperclip Pattemed Coaster

oo 4

Plain Round Coaster Plain Square Plain Square Coaster
Coaster.001

S 4 ©®

Seashell Castanets ~ Shopping bag Silhouette Logo
Handle Coaster

.
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00 g— Use the View as lcons button and View as List button near the top right-hand side of the
OO 8= window to change the view of your designs in the right panel.

As your library continues to grow with additional content, you may find it convenient to customize your
library with new folders and sort designs according to your liking. You may add new custom folders by
right-clicking and selecting “New Folder.”

As new folders are created, you may immediately name your folder a desired name. Once your new folder
has been created, you can drag and drop objects into the folder. Right-clicking on a folder will allow you

to create a new subfolder for that selected folder, delete the folder (along with all contained content), or
rename the folder.

In addition to customizing folders, you may also adjust any of your objects within the library. Right-clicking
on an object will allow you to delete the object, rename the object, sort the objects in the current folder, or
show/hide the object properties.

Adjusting Objects

When you have an object in your design space, you have the ability to check or change its dimension,
rotation, and scale. Make sure the object is selected, and then go to the toolbar above the design space.
You'll see a drop-down menu where you can select “Dimensions,” “Rotation,” or “Scale.”

C 9QQ i« ¥HE

H 21.68 D 50.00

Dimensions v w s000

- Dimensions

Rotation

millimeters E

Scale

With the dimension and scale options, you can change the width, height, and depth dimensions. You even
have the ability to lock in the ratio aspects by clicking on the lock icon.
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Accessing Free Designs

Click the Library panel to view the Silhouette designs you have. The
Silhouette Alta® includes 25 free designs to help you get started.
Connect your Alta to your computer and register your machine to
get your 25 free designs.

To access those 25 Free Designs, you must follow these steps:

1. Make sure you have completed the setup process by
registering your machine (and creating a Silhouette
account, if applicable), checking the box contents, and
installing the Silhouette 3D® software.

2. Once your machine has been registered, your account
has been created, and the software has been installed,
you're ready to access your free designs.

3. Open the software. When you do, you will see the panel
on the right-hand side that says Silhouette Cloud. Log in
using your Silhouette account credentials.

4. Next click on the Library folder to open it. Then find
the folder that is labeled “Free with Machine” and click
onit. Then click on the Alta folder. As long as you've
successfully registered your Silhouette Alta® on the
setup page listed above, you should find the free models
to print with the Alta.

Getting Started with your Silhouette Alta®
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( Cloud = Library ® Free Designs Az H

Q
v - -

Cutipets - Set 1 Desk Tidy Diamond
/ :
Dolly Clothes Peg Duck Kit Flower
Embellishment Coll...
Heart Embosser Heart Paperclip Jigsaw Dough Cutter
Keyring Blank Mini Trowel Paperclip
Collection
PolyCat PolyDeg Ruler
Seaside Charms Six-Sided Die Six-Sided Die
- gj
Star Box Collection Yoyo
v i i com

_

Last Synced: 8/6/2018 11:04:35 AM  441.1 MB used of 1.0 GB
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Importing Designs

One great feature of the Silhouette 3D® software is that you can import designs from any third-party
sources as long as the designs are in a compatible file format (i.e. .STL and .OBJ). There are many third-
party websites online that offer 3D designs for you to use. Just make sure you comply with the appropriate
product licenses that are listed when you download the file.

When larger designs created outside of Silhouette 3D® are imported into the software, a window will
pop up and ask you if you'd like to decrease the size of the object to fit the print bed. If you click “Yes,”
the software will autoscale the design to a smaller size. If you click “No,” the object will be imported at its
original size. You will still have a chance to decrease the size of the object manually.

Importing Multiple Designs

Many designs that are imported can come with multiple pieces you can print and glue together. Take this
drum set design for example. There are many pieces that make up this design, and to make sure they all fit
together properly, you want to make sure you scale them all together.

!'_

Lot Symced BAZIMERIZIPM 107 KB used of 1.0 6B
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To import multiple files, follow these steps:
1. Open Silhouette 3D® and click on the folder icon in the upper left-hand corner or click File and
select “Open.”

2. Locate the files you wish to open.
Note: Often when you download designs from a third-party source, the designs come in a zipped folder.
In order to successfully import the designs into Silhouette 3D® you must first extract the files before
you attempt to open them in the Silhouette software.

3. Click on the files you wish to open. To select multiple files, hold down the Control or Command
key and click on the files.

€= 1 L b ThisPC » Local Disk(C:) » Users + abass b Downloads » drum_set_model + files v ¢ | | Searchfiles P
Organize v New folder Er [ @
— Date modified Type Size
B Deskiop 8/2/2018445PM  STLFile T45KB
" 8/2/2018445PM  STLFile T0KB
‘. Recent places 8/2/20184:45PM  STL File 132KB
% Dropbox 8/2/2018445PM  STLFile 133KE
@ Creative Cloud Files 8/2/2018445PM  STLFile GO KB
8/2/20184:45PM _ STLFile 64 KB
1% This PC 8/2/2018445PM __ STLFile 64KB.
| B Desktop 8/2/2018445PM  STLFile TKB
|1 Documents £/2/2018445PM  STLFile 112KB
s 8/2/2018445PM__ STLFile 45KE
i Music £/2/2013445PM  STLFile. 54 KB
| Bl Pictures
| B Videos
&, Local Disk (C)
3 Network Drive (N:)
. ) = T oo | bassdrum” ' v‘ |'.;3¢'.sm{m-;-.s|_udn3;’.oh;'.s v\

4. Decide whether you want to have the software scale the design automatically. The software will
automatically detect whether the design will be too big to print.

5. Proceed to alter or change the designs or print settings as needed.

Adding multiple designs at once is a great way to make sure you are scaling your designs, whether
manually or automatically, the same amount. Plus, all of your designs will be on the same page, and you
won't have to worry about working with multiple documents.

Getting Started with your Silhouette Alta® 14



Opening Designs

To open a design in your Silhouette library, navigate to the folder the design is in. Once you find your
design, double-click it. It will open on the Design page in Silhouette 3D®,

If you have another design that is saved outside of Silhouette 3D® that you would like to print with your
Alta machine, you can open that design in Silhouette 3D®. Simply go to File>Open or click on the folder

icon located along the top of the page and find the file you wish to open. You can get designs from any
third-party source you would like as long as they come in the form of .S3D, .STL, or .OBJ files.

Organizing Designs

You can organize your designs within your Library for your convenience by creating new folders for your
designs.

With the Library folder highlighted, right-click and select New Folder. Then type a name for your new
folder.

Drag any design from the right panel into your newly created folder in the Folders panel on the left. The
numbers in parentheses next to each folder indicate how many objects are included in each folder.

( Cloud = Librany Q “‘z HH

3D Studiocfiles (6) Project Designs (4)  Recent Downloads
{21)

User Designs (25) Free Designs (25) Single Models (49)

Snap Kits (107) Untitled Folder (4) eBooks

To access the 25 free designs that come with your Alta machine, refer to page 12 of this manual.

¢
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NHNUNATNBA

www.delinit.by
15 Getting Started with your Silhouette Alta®



Searching for Designs

At the top of the Library window, you will find a Search box. Click in the text box and type a keyword to
search your library of objects. Search results will display in the right panel.

Bat Stake Birthday Buckle Heart

@@

Using Designs in the Library

Using the folders in the Library, navigate to a design that you would like to print. Double-click the design to
place it on your page in the software.

If the design is a 2D design, the software will give you the option to import your file as a 3D object. Some
2D designs will work better than others, so you may have to play around and do some 3D test prints to
see which designs will work the best. There are six different 3D import options you can choose from:
extrusion, cookie cutter, jewelry box, stencil box, stencil, and wax pendant. In the example below, we just

did a simple extrusion to give the diamond earrings design more depth.

CANCEL

Diamond Earrings by Lori Whitlock—Design ID #268357
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Stote Tab
The Silhouette Design Store contains designs for you to print with your Silhouette Alta®. To access the

Design Store, click the Store tab in the upper-right corner of the software. Your default browser will launch
and automatically pull up the Design Store. From there you can search for designs you can print.

New Bundles Deals Subscriptions Credit Boost u 8 ?
€ri$0.00  FREE

Designsv  Fontsv 3D  Patterns  Projects Eearch

/4

)

v o the s

BTN * FREE DESIGN - 30% OFF
CREDIT
B0OST [

NEW DESIGNS

At the Design Store, you'll find a variety of designs to purchase, including 2D designs and 3D designs.
Search for designs by keyword using the search bar or by category by using the menu bar.

New Bundles Deals Subscriptions Credit Boost u 8 ?
Cr:5000  FREE

Designs¥ Fonts 3D Patterns  Projects Eearch

25% OFF

Phrases & Monograms
Plants & Animals

Travel & Seasons

Around the House > Combo Shapes
Borders & Backgrounds > Curved Line Shapes * FREE DESIGN *
Cards & Labels > Flourishes CREDIT
Celebrations > Straight Line Shapes
Family & Friends > Symbols BOOST
Flourishes & Shapes > SEE ALL FLOURISHES & T R B
Fun & Games > SHARES
Holidays > .
Kid Stuff > Simnies Deiign Sule

>

>

>

>

All Summer, Camping.
Work, Scheol, Religion ) -&-Vx?\;m:Dq:iu-ns- )

ALL DESIGNS
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Browsing for New Designs

The Silhouette Design Store works like any other web page and can be navigated by clicking on various

links to browse new releases, popular designs, etc. The home page contains popular and new designs that

you may be interested in.

New Bundles Deals Subscriptions Credit Boost

igiiyte

Designs¥ Fontsv 3D Patterns  Projects

Cr: $0.00 FREE

FANCY BULB VASE \
by Silhouette

D);Sign ID #269191 b
Published: 6/06/2018

Description:

A modern sloped vase.
LICENSE TYPE:

This design is available for royalty-free commercial use when purchased at commercial rates.

[Personal v Moreinfo
$2.99
add to wishlist n u

d269191

SIMILAR DESIGNS FROM OTHER ARTISTS

% § i

$0.99 E

E $0.99 E $0.99

$0.99 E $0.99 E‘ $0.99 g

o aw

For now, try downloading a design you want. Click on the design in the search results to view details about

the design.
Click the Add to Cart button to add a design to your shopping cart.

Locate the shopping cart icon in the upper right-hand corner of the window and click
@@ it toview your shopping cart.

Click the Checkout button to proceed. At this time the system will ask you to sign in before downloading

the design. Creating a new account takes only a few seconds. Click the “Sign up FREE" link on the login
page to create a new account.

Getting Started with your Silhouette Alta®
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Creating an Account

Several different account types exist. Once you're more familiar with the Silhouette Design Store, you may
wish to purchase a subscription and download dozens of designs each month.

]

Guess What?! All Easter, Spring, Plant & Animal designs are on sale! Click Here "
I ———————
* New Bundles Deals Subscriptions Credit Boost a 8 .
Cr:$0.00  FREE
{ } Designsv Fontsv 3D  Patterns  Projects p

Choose Your Subscription

Length PLAN PRICE MONTHLY CREDITS FEATURES

- 60 day credit rollover

Wt g $9.99 $25.00 || ot simouereraroos

- *
& Month $0.40 average cost per download

3 Month

= Most downloads are $0.99 per file. Pricing may vary due to promotions, and other discounts. m
Click here to compare all of the subscription plans.

In order to create a free account and buy designs one at a time, choose the “Sign up FREE" option.

You will be asked for your name, email address, and password in order to create an account. Type your
information and click the Sign Up button.

Guess What?! All Easter, Spring, Plant & Animal designs are on sale! Click Here

“ New Bundles Deals Subscriptions Credit Boost BB signin ?
$0.00

‘ } Designsv  Fontsv 3D  Patterns  Projects Search p

Sign up for a FREE account

Setting up a free Silhouette Design Store account couldn't be easier - just fill out the form below and you're ready to go. You can
then use your email address and password to log in to your account and begin downloading shapes right away. We keep a record
of all the designs you purchase. That way. if your designs are ever lost (or if you switch computers), you can easily retrieve all the
designs you have acquired from the Silhouette Design Store (we are unable to keep a record of the designs you create on your
own and suggest you create backups to prevent accidental loss).

name: lane Smith
email: lismith@mail.com

password Great

confirm password: sssssssssssss

currency: U.s. Dollars e

¥ send me newsletters about new Silhouette products and information
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Once your account is created, you will need to access your shopping cart again and try the
E checkout process once more. You will be asked to validate your password each time you
download designs.

Type your password to authorize the download.

)

Guess What?! All Easter, Spring, Plant & Animal designs are on sale! Click Here

v -
MNew  Bundles Deals Subscriptions Credit Boost 8 "
Cr$0.00  FREE

‘ ’ Designsv  Fontsv 3D Patterns  Projects D

Terms of Use

By downloading these images you are entitled to keep them for personal use as long as you wish. You are NOT entithed W redistribute these
images electranically, or in print, or in any other medium without written consent or a commercial license from Silhouette America, Inc.

Payment will automatically be processed to:

Silhouette America
618 M. 2000 W. Bldg 2
Limdan, Litah, 82042

Ty pPe your passwor d
Please type your password to authorize the download of these items:

Subrmit

Staring Your Trial Subscription

With the purchase of a new Silhouette machine, you get a trial subscription to purchase designs from

the Silhouette Design Store. After registering your machine at silhouetteamerica.com/setup, you

will receive an email with a unique code that entitles you to a one-month Basic subscription to the
Silhouette Design Store. Follow the directions within the email to activate your trial subscription and begin
enjoying the Silhouette Design Store.

<9

Gumes What?! All Exster, Spring, Plant & Animal designs are on salel Click Here
—m

|
New Bundles Deals Subscriptions Credit Boost v 8 ?

Cr-30.00 FREE

Patterns Projects

Choose Your Subscription

Choose your start date

Payment & Billing Info

Do you have a promation cade or a prepaid subscription gift card? Enter your code here for your discount.
- Ex
How would you like to pay for your subscription?
® Monthly: $9.99 Includes $0.00 tax today and 11 monthly payments of $9.99 Includes $0.00 tax starting on 04/28/2018

C Up-Front: Pay one payment of $113.89 includes $0.00 tax today and save 5%

Card Information Billing Address
New Address
SD visa == 2 S —
Address: |
Card ber: |
. Address 2:

Your available subscription credits can be viewed in the upper right-hand corner of the screen below your
name.
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3D Punt lab

Preparing to Print

When you click the 3D Print tab, the software will automatically center your object in the print space. Be
sure your design is small enough to fit within the red circle, which is the print margin.

Turn the Silhouette Alta® on by pressing the power button on the side of the machine and waiting for the
machine to start up. Make sure the printer is connected to your computer with the USB cable.

Filament Loading Lever

/ Print Head

/ Platform

On/Off Switch

Applying Platform Tape

The platform, also known as a build plate, is what your 3D object will be built on, so it's important that you
prepare it. Using platform tape protects the platform and helps the filament to adhere properly.

The liner for the platform tape is perforated down the middle to make it easier to apply. Start by taking off
the liner half without the notch and line up the top half of the platform tape (with the liner still on) with the
platform’s notch. Rub the bottom half of the tape in place. You can use your hand or the spatula tool, but
the most important thing is to make sure there are no air bubbles or creases in the platform tape when it is
applied to the platform.

Then remove the other half of the liner and rub the remaining tape in place. Again, make sure there are
no air bubbles or creases. If your platform tape is not lying completely flat against the platform, your 3D
object won't print properly.

After the tape is adhered, place the platform under the print nozzle with the tape side facing up. Make sure
the notch of the platform lines up with the notch at the bottom of the machine.
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Inserting the Filament

To load the filament in your Alta 3D printer, start by opening Silhouette 3D®, and power on your Alta. In
the software, click on the 3D Print tab. In the upper right-hand corner, ensure that your machine has been
selected. With the Alta selected, click on the Filament button. Next, click on Load Filament and go through
the following steps to load your filament properly.

Place your filament spool on top of your machine and put the roll of filament on the spool. When using
filament that comes in either a loose roll or a reel, it is important to make sure that you keep a hold of the
leading end because the filament can become tangled.

On top of the machine, there is an eye and the filament clip. Feed the filament through the eye and the
filament tube. To prevent the filament from becoming tangled and jamming the machine, push the filament
tube back through the eye. Then insert the filament tube through the filament loading lever. Press the tab
on the filament clip to open the hole where you can insert the filament and the filament tube. The filament
tube doesn't need to be pushed in very far; it just needs to go in far enough to the point where the loading
lever grabs it when the lever is released. The filament should be pushed through the filament tube about
an inch or so, until you see the filament in the filament hose near the top of the machine.

Click Next in Silhouette 3D®, and then click Load. The machine will feed the filament through the inner
print tube and heat up the print head. The print head will then move down and print a small amount of
filament once the filament is warmed up.

Make sure you store any filament you are not currently using in a watertight container to maintain its
quality. Humidity will cause the filament to become brittle and render it unusable.
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Selecting the Print Settings

When you first open the 3D Print tab, you'll notice that any designs, both on your print bed and in the
gray holding area, are still there, but each object will be put into its own print job unless you group objects
together prior to going to the 3D print step.

You'll also notice that a box comes up with a list of your print settings. Here you can change the type of
print settings you want and change your filament, if necessary.

Quality  High Quality (PLA) - default v ﬁ
Print Estimates (M 0:534:07 i 1.59m

Printer  ALO3R6CIA v
Status Ready

Temperature 115°C /239 °F

Silhouette 3D® has default print settings, which are the recommended settings, for each print type, but you
can adjust these settings by clicking on the plus sign on the right of the drop-down menu.

Select the profile you wish to change. There are four different sections: Layers and Perimeters, Infill,

Support Material, and Speed and Extrusion. After you are done making any adjustments, you can click the
Save Settings button to save a new print profile.

Profile Standard (PLA) - default

Layers and Perimeters Infill Supports and Adhesion Speed and Extrusion

ayers
Temperature
First Layer Height

Layer Height

.5hells (Surface Layers)..
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Layers and Perimeters

»

»

»

»

»

»

Infill
»

»

Temperature: the temperature of the filament layers of the 3D print. Often different filaments
have their own ideal printing temperatures. If you are having problems with prints with webbing
or prints that are brittle, you may need to adjust the temperature. Tip: A good printing range for
PLA filament is between 180°C and 210°C.

Filament Color Temperature Range

Black range 180-210°C, 185-195°C optimal
Glow-in-the-dark range 180-205°C, 190°C optimal

All other colors range 180-220°C, 190-215°C optimal

First layer height: the height of the first layer of your printed image. Getting the right first layer
height in place is important because the first layer is the foundation of your print.

Layer height: the height of each layer of filament. It's similar to resolution in that a thicker layer
height will have less detail.

Perimeter shells: how many layers will print around the infill (not part of the infill)

Top-layer shells: how many layers will print on the top of the print. Tip: A good rule of thumb is to
have the thickness of the top layers be about 0.5 mm think to prevent gaps or holes in the top of
the print. So if you're printing a layer height of .25 mm, you would need two top layer shells.
Bottom-layer shells: how many layers will print at the bottom of the object.

Infill Density: how thick the support material is in the middle of the design.
Infill Overlap: can be adjusted to prevent gaps between the perimeter and top layers.

Supports and Adhesion

»

»

»

Speed

»

»

Supports: allows you to print your design with support material if the object has any pieces that
will print at an angle greater than 45°.

Brim Width: how many perimeter loops go around the first layer to help support the base and to
provide more surface area for prints to prevent warping

Brim Distance: how far away the brim is from the first layer.

You can change the speed in which each layer is printed. The speed is often dependent on the
quality of the print and the temperature of the filament. Generally, the faster the machine is
printing, the lower the quality. A good printing range for PLA filament is between 30 mm per
second and 90 mm per second.

Tip: If you're printing at a lower temperature you may want to increase your print speed.

Extrusion Width

»

How thick each layer, such as the first layer or the perimeter layer, is when it is printed.

Getting Started with your Silhouette Alta® 24



Printing Your Design

After you are done making any adjustments to your print settings, save any changes. Silhouette 3D® will
build a 3D model according to the print settings you input, and you'll be able to see how the printer will
construct and print your object. Click the Play button at the bottom of the page and watch to see how the
printer will print your object.

In the upper right-hand corner, there is a box that shows you the status of the Silhouette Alta® as well as
the estimate of the filament length in meters and an estimate of the total printing time.

When the machine has heated the filament to the indicated temperature set in the print settings, the
machine will begin to print the design.

After your machine is done printing the design, give the design a few minutes to cool. Then gently remove
the design from the platform. Begin to break away the first layer and any support or hanging pieces to
reveal your printed design.

Calibrating the Alta

Your machine already comes calibrated, so when you set the Alta up for the first time, it should be
ready to go. But should you run into an issue with your machine's calibration, you must start the
calibration process from Silhouette 3D®,

To do so, you can follow the instructions listed below or view the Calibrating Your Silhouette Alta®
video on YouTube.

1. To check the calibration, go to the 3D Print tab in Silhouette 3D®.

2. Go tothe box on the upper right-hand side and make sure your machine is selected.

3. Click on the circle icon with three dots in the left-hand corner of the box.

4. The software will tell you to take a piece of copy paper, cut it in half length-wise, and place it
on the platform that already has platform tape onit. The paper is what you will use to test the
optimal position of the print head. Don't use a folded up piece of paper. If the piece of paper you

are using is too thick, the calibration will be off. When you've got a piece of paper ready, click
Start in Silhouette 3D®,
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Calibration

Place a piece of copy paper on the

Print Bed.

Attempt to move the paper each
time the Print Head touches the

base.

5. Hold the paper on one end. The machine will move the print head to three different points: the
front-left position, the front-right position, and the back position.

6. When the print head goes to each position, attempt to slide the paper under the print head to
see whether you can move it. The paper shouldn't be too easy to move. You should feel some
resistance when you try to move it, but the paper shouldn't be so hard to move that you bend or

damage it.

7. Inthe software, indicate whether moving the paper at each point is easy, normal, or hard and
click Next. The software will then tell you which section needs to be adjusted.

8. If you indicated a point was too easy, you need to tighten the screw.
9. If you indicated a point was too hard, you need to loosen the screw.
10. Once you've adjusted the screw, click Test Again in the software.

11. The Alta will lower the print head and have you test the point again with your piece of copy
paper.

12. When all of the points are normal, you've completed the calibration process.

Getting Started with your Silhouette Alta® 264



Tloublestooling

Silhouette is working hard to add additional resources to help you make the best 3D prints. Keep checking
back on our website, blog, FAQ page, and YouTube channel for more troubleshooting tips and tricks.

If your machine stops printing, check the filament. It may have run out or it may be stuck. Sometimes you
can simply pull the filament out from the top of the machine. But if the filament is stuck inside the hose,
there is no way to pull it out from the outside, and you'll have to remove the filament hose to dislodge the
filament. For more details on how to remove jammed filament, please read Silhouette's Clearing Filament
Jams document.

If the lines are squishing into each other when layers are being printed, the print nozzle is too close and
the machine needs to be recalibrated.

If the lines are printed too far apart and aren't adhering to each other, the print nozzle is too far away,
and the machine needs to be recalibrated.

If the nozzle is moving but no filament is coming out:
The filament is stuck. Sometimes the filament gets stuck near the top of the print hose. The gear that
moves the filament in and out of the extruder can wear down part of the filament and cause it to stay
in place rather than feed through the machine properly. To fix this, simply pull out the filament, find the
section that is worn down (it won't be as smooth or as thick as the rest of the filament), and cut off
that part. Then reload the filament into the machine. The machine should print normally.

The filament on the spool is tangled. It is easy for the filament to become tangled, and it may snag
and not come off the reel easily. To untangle it, you'll have to remove the filament from the machine,
unravel the filament from the reel until any tangles are removed. Carefully place the filament back on
the reel and take care not to let it tangle again. Then reload the filament into your machine.

The nozzle head is clogged. You can use the nozzle cleaner tool (the small tool with the thin metal
piece and the plastic handle) to poke it inside and up through the nozzle head a few times to try and
move around any plastic that may have solidified. Also, check outside and around the nozzle head
because sometimes the plastic will coat the entire shell of the metal extruder portion of the nozzle
head. If fixing those two things doesn't solve the problem, you can remove the hose attachment from
the extruder head and use the small hex key that came with your machine to push the filament out.

If a print has incomplete sections:
The filament is stuck. This tends to happen when the extruder isn't able to pull out the filament easily.
Ensure that the filament doesn't have any tangles and that the machine can easily pull more filament
to load into the machine.

The printing temperature may be wrong. If the filament is too cold, the filament doesn't flow as easily
as it could, and that can cause the gear in the Alta to grind down a specific spot of the filament. This
may cause the filament to become stuck.

If you're having trouble with the quality of your 3D prints, check out this blog post that describes several

common printing issues: http://blog.silhouetteamerica.com/archives/alta-your-thinking-with-quality-
printing.
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Complete Software Manual

View the complete, illustrated User's Manual within Silhouette 3D® by clicking Help > Manual.

Website

Visit the tutorials section of www.silhouetteamerica.com for help with specific features and step-by-step
instructions on how to print objects with the Silhouette Alta®.

Blog
Visit the official Silhouette blog at blog.silhouetteamerica.com for ideas of new projects you can create.
Many blog posts contain step-by-step instructions for advanced uses of Silhouette products and software.

Newsletter

Sign up for the Silhouette newsletter at www.silhouetteamerica.com to receive product updates and
special offers via email.

Customer Service

If you have any further questions, feel free to contact customer service:

Silhouette America, Inc.
support@silhouetteamerica.com
https:/www.silhouetteamerica.com/contact
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